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The Flipped Classroom: A How-To For Educators
Phoenix, AZ ¢ April 13, 2015

Robert Cooney @EMEducation - Rahul Patwari @RahulPatwari




“Watching a teacher do anything is akin to training for a marathon by sitting on the couch
watching videos of great marathoners and eating chips. If you want to be a better runner, you
need to run.”

-Eric Mazur

Objectives

@ Describe common methods for delivering instruction to independent learners in an asynchronous fashion

@ Explain the tenets of multimedia design principles and how they affect educational content design and delivery

@ Demonstrate the creation of a simple module using the tools demonstrated

@ Construct a simple classroom activity based on a pre-recorded video that incorporates Bloom’s high-level
cognitive objectives

In this 90 minute session, we will be building a flipped classroom session on how to read a chest x-ray as an example.
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Tools You'll Need for the Workshop

This will be an interactive session with some didactics, but a lot of time spent on creating materials. To get the most of out of this session, it
would be helpful if you brought the following items:

@ Laptop computer or iPad

@ Presentation Software (Keynote, PowerPoint, OpenOffice, Google Slides)
@ Pen

@ This Handout
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Anatomy of a Normal Classroom

In class - passive transfer of knowledge At home - active application of the knowledge
watch lectures as classwork do problem sets as homework
lecture in which there is little interaction between instructor and learner student applies the knowledge alone without assistance

Anatomy of a Flipped Classroom

At home - passive transfer of knowledge In class - active application of the knowledge
watch lectures as homework do problem sets as classwork
student reviews knowledge on their own time applies the knowledge in a social context
(can review as many times as needed) can get help from other learners or instructor

The flipped classroom Page 5 of 20



Tip 1: Create Clear Objectives

An objective is a description of a performance you want learners to be able to exhibit before you consider them competent. Learning objectives are
promises to your students (“this is what I'll give you the skills to do”). Students view objectives as expectations (“when I'm done, I'll be able to do

this”).

Objectives can be made clear by specifying the ABCD's: audience (the student will be able to), behavior (what the student should be able to do),
conditions (the conditions under which they should do it) and degree (how well they should be able to do it that we find acceptable). For example,
we should say more than “take a good history and physical.” If we specify the components:

@ audience: the M4 student

@ behavior: a differential diagnosis focused history and physical
@ conditions: in the emergency department clinic

@ degree: at the level of an intern

Assembling this into an objective we’d get: By the end of their rotation in Emergency Medicine, the M4 student will be able to take a history and

physical focused using the differential diagnosis.

For the home component of the lesson, the educator should choose lower-level Bloom'’s tasks (knowledge, understanding). For the classroom
activities, the educator should focus on the higher-level tasks.

REMEMBER UNDERSTAND

Summarize, Explain,
Interpret, Describe,
Compare, Paraphrase,
Differentiate,
Demonstrate, Classify

List, Name, Identify,
Show, Define, Recognize,
Recall, State, Visualize

lecture, visuals, video,
audio, examples,
illustrations, analogies

questions, discussion,
review, test, learner
presentation, writing

RECALL & RECOGNITION

APPLY

Solve, lllustrate,
Calculate, Use, Interpret,
Relate, Create,
Manipulate, Apply,
Modify

exercises, practice,
demos, projects,
sketches, simulation, role

play

ANALYZE EVALUATE CREATE
Analyze, Organize,
Deduce, Contrast,

Compare, Distinguish,

Discuss, Plan, Devise

Evaluate, Choose,
Estimate, Judge, Defend,
Criticize

Design, Hypothesize,
Support, Schematize,
Write, Report, Justify

problems, exercises,
case studies, critical
incidents, discussion

projects, develop plans,
construct simulations,
creative exercises

case studies, critiques,
appraisals

APPLICATION & PROBLEM SOLVING
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Workshop Activity

For our given lesson of teaching how to read a chest x-ray, create three lower-order objectives for the home module:

Next, create three higher-order objectives for the in-class module:
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Tip 2: Find Pre-Existing Home Learning Modules

The idea of the flipped classroom has recently gained popularity, however the idea is quite old. Asking students to read first prepare for tomorrow’s
in-class discussion is an old example. However, recent technology has made it easy for many people to create content. Video and audio can be
recorded and edited from most smart phones.

Finding Resources For Flipping

However, you don't have to create home modules on your own if there already are some good materials in existence. However, be sure these other
people’s modules address your objectives. Here are some good places to start your searching.

A dedicated FOAM search

@® Foam Search:
http://googlefoam.com/

See if you can find a module on reading a chest x-ray that someone has already created which fits with your objectives.

Images

https://kchemimage.wordpress.c

om/
https://kchemekg.wordpress.com

A
http://lifeinthefastlane.com/resou

rces/clinical-image-database/

http://lifeinthefastlane.com/resou

rces/normal-x-ray-database/

http://lifeinthefastlane.com/resou

rces/radiology-database/

http://lifeinthefastlane.com/resou

rces/ecg-database/

Video

http://lifeinthefastlane.com/resou

rces/podcasts/
http://vimeo.com/smacc

https://www.youtube.com/chan
nel/UCHaNOQfnfpRdsgMdEBLIFaC
w

https://www.youtube.com/chan
nel/UC4TNnL3pomSnujPcXwmva

A

https://www.youtube.com/chan
nel/UC_yjveGdyx6maagHkHaD-_

bg

Podcasts

@ http://lifeinthefastlane.com/resou

rces/podcasts/

@ hitp://freeemergencytalks.net/

Alternatively, you can make your own modules for use at home. Keep the lessons short, around 15 minutes for videos and podcasts. Readings can be
longer, but you should have a general idea of how much time it will take to complete the out of class work. The next three tips will explore how to

make your own modules.
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Tip 3: Use Sound Theory To Create Your Lessons

These principles of e-Learning championed by Richard Mayer have
been shown to improve learner learning when material is presented in

Long Term
Memory

The World Sensory Memory Working Memory o

Verbal Knowledge
a digital format. For a good summary on this subject, we refer you to D Me:d;
Ruth Clark and Richard Mayer, E-Learning and the Science of Images Visual

Instruction, 3rd edition, Pfeiffer Publishing, August 16, 2011.

1. What material to include
a.

b.
C.

d.

Model integrate

Multimedia Principle - People learn better from words

and pictures than from words alone.

Modality Principle - People learn better from graphics and narrations than from animation and on-screen text.
Redundancy Principle - People learn better from graphics and narration than from graphics, narration and on-screen text.
Coherence Principle - People learn better when extraneous words, pictures and sounds are excluded rather than included.

2. Arranging the material

a.
b.

Signaling Principle - People learn better when cues that highlight the organization of the essential material are added.

Pre-training Principle - People learn better from a multimedia lesson when they know the names and characteristics of the main
concepts.

Spatial Contiguity Principle - People learn better when corresponding words and pictures are presented near rather than far from
each other on the page or screen.

Temporal Contiguity Principle - People learn better when corresponding words and pictures are presented simultaneously rather
than successively.

Chunking: Segmenting Principle - People learn better from a multimedia lesson is presented in user-paced segments rather than as a
continuous unit.

3. Voice & personalization

a.

Personalization Principle - People learn better from multimedia lessons when words are in conversational style rather than formal
style.

Voice Principle - People learn better when the narration in multimedia lessons is spoken in a friendly human voice rather than a
machine voice.

Image Principle - People do not necessarily learn better from a multimedia lesson when the speaker’s image is added to the screen.

If you want to learn more about the theory, here’s a short video: youtu.be/BcWSUnXz8kw
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https://t.co/58YnFt6XOr

Tip 4: Storyboard your module

Movie makers use storyboards to plan their projects. Our educational modules are a similar production. Use the following boxes to plan what will be
part of your home module.
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Tip 5: Take Care With Images

There are two dangers lurking when using images: copyright law and HIPAA. Most pictures obtained through an Internet search engine are often not
licensed for reuse and put you in potential copyright trouble. There are, though, many resources where you can get images for reuse.

N a Putting “chest x-ray” into a Google Image search yields mostly
pictures which shouldn’t be reused. By selecting “Search Tools” >
“Usage Rights,” the search can be further refined to include those
graphics ready for reuse. Most are supplied under a Creative
Commons license which gives people “a simple, standardized way

. v/ Not filtered by license . . . . »
o to grant copyright permissions to their creative work.
Labeled for reuse with modification .-
’ Labeled for reuse ! ‘ X .
. . R Another good source of images available for reuse
N a abeled for noncommercial reuse with modification

GO 8[6 chest x-ray

Web Images Books Videos Maps More ~ Search tools

Size v Color ~ Type ~ Time v Usage rights ~ More tools ~

il

Normal Pneumonia | abeled for noncommercial reuse Mac is WikiMedia Commons (part of the same

organization as Wikipedia). This site is full of many .
high quality medical images provided for public
reuse (with proper attribution).

WIKIMEDIA
COMMONS

Other sources for images are listed in Tip 2.

Alternatively,
you can take

. Information outside the cropped area remains in
your own images. Be sure to follow a few rules: the file and can be easily recovered.

@ Don't use patient information without a consent

@ Remove any personal health information. Simply cropping (or masking) out the patient’s
name and saving an image keeps all the information with the picture. It is a simple matter
to “uncrop” the image and reveal the identifying information. Information may also be
saved in the meta-data (EXIF). Search your image manipulation software’s documentation
for the correct way to destructively edit the photo (no original information is saved) and
remove meta-data.

@ Alternatively, you can create your own images with drawing programs like Photoshop or
Pixelmator (bitmap image software) or lllustrator or iDraw (vector editing software).
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Tip 6: Create resources with familiar technology

At home modules can be anything from assigned readings to a print out of your slides but today’s learners appreciate and can benefit from video
lessons. However, do not make the mistake of simply recording yourself giving your lecture. There are

Hardware Create Content Screen Recorders Video Editing Software All-in-One Options

Microphones PowerPoint / Keynote (has Camtasia ScreenFlow (Mac) Knowmia

- Samson Meteor recording capabilities built-in) Snagit Windows Movie Maker Doceri

- Blue Snowball . . Screenr iMovie / Final Cut Pro (Mac) EduCanon

- Blue Nessie Drawing Programs (Paint, . .

- Built-in microphone lllustrator, SketchUp) Screencast-o-matic Socrative

Quicktime (Mac) Explain Everything (iPad / Android)

Drawing Tablets ScreenFlow (Mac) DoodleCast Pro (iPad)

- Wacom Bamboo iShowU HD Pro (Mac) Vittle (Free version available)

What is contractility?

The classic example of the flipped classroom comes from the Khan Academy (see picture to the left). What
does it take the create content on this level? Sal Khan uses a Wacom Graphic tablet and stylus, headphones
with a built-in boom microphone, and would record in his closet.
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Peter Norvig and Sebastian Thrun, creators of one of the first
immensely popular MOOC's in Artificial Intelligence used only a pen,

paper and camera.
S &

Now also a significant number of app and web-based apps specifically é
for flipped classroom creation.

(ES NO

D-SEPARATION

For the purposes of this session, let’s try recording a presentation with
PowerPoint or Keynote.

W Window & Help
4 i::ﬁ:m o iy ﬁ:i In PowerPoint, after creating your slides using the Multimedia principles, you'll
1@ Broadcast Side Show... go to the “Slide Show” menu and select “Record Slide Show.” Then you can
anj  Custom Shows > | startrecording and speak your presentation while you advance the slides. Your
. & built-in microphone (or attached microphone if you have one) will record your

Rehearse v
voice. The video comes from the screen.

Record Slide Show

s g Action Buttons > —
iy When you are done, pick the X labeled “End Show.” From the File menu, you
ransitions...
Hdeside o can pick “Save as Movie-
Set Up Show...

acussed reated o cinica otaions and talet 39
Mileniss' facun

ge View Share Window Help - 00:00:05
Play Slideshow 8P Yearke , . .. . ;
/ In Keynote, you'll do something similar. After your slides are completed, e pos 1 h v
T Tr—— select “Record Slideshow:-+" from the Play menu. Go through your slides, ~gm_

while narrating, and the microphone will record your voice.

Rehearse Slideshow
Customize Presenter Display...

To save it as a move, from the File menu select “Export” and choose
“Quicktime---"

The flipped classroom Page 13 of 20



Workshop Activity
For those of you with laptops and presentation software, use PowerPoint or Keynote and create a set of slides following the multimedia principles
listed above. Use the “Record Slideshow:-"" feature to narrate and record a short module on how to read a CXR.

For those of you using an iPad, some very simple all-in-one programs that let you draw on the screen are listed in the table above. DoodleCast Pro is
a very simple and cheap program. Vittle allows you to make short videos with their free version.

You'll need to find some x-rays from the public domain (use the resources listed above).

Notes and Questions:
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Tip 7: Upload your Modules to the Public Domain
Putting your material in the public domain has several benefits:

1. It allows for easier access by learners on various devices

2. Itallows learners outside of your institution to also benefit from your material (participate in Free Open Access Medical Education:
FOAMed).

3. Instructors from other institutions can incorporate your materials into their teaching, thus broadening your impact Demonstrated
international adoption of your teaching materials (often with testimonials to include in your promotions packet)

4. Let the big websites handle the streaming, storage and video & comment management

Some commonly used public repositories include: For videos:
@® YouTube (www.youtube.com)
@® Vimeo (www.vimeo.com)

For written materials
@® MedEd Portal (www.MedEdPortal.org) Your own website or blog
@ WikiSpaces Education (www.WikiSpaces.com)
@® WordPress (www.wordpress.com, www.wordpress.org) o Weebly (www.weebly.com)
@ SquareSpace (www.SquareSpace.com)
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Tip 8: Build Quizzes to Test Comprehension of the Home Modules

To test comprehension of the objectives of the home modules (and to make sure that learners complete the modules), build quizzes. There
are many online form generators which will tally answers for you (such as Survey Monkey and Survey Gizmo). You can also use Google
Forms or WordPress’s Contact Form.

The contact form in WordPress allows you to ask questions of your Forms in Google’s suite of applications can easily be embedded
learners. Their answers are automatically emailed directly to you. into a website. The answers are collected in a spreadsheet.

Form builder Email notifications Page 1 of 1

Trauma Pre-Quiz

This is to be done before coming to class.

Here’s what your form will look like

Which of these interventions is most often ded in the tr tically injured
Name patient.
Intubation
I = Blood transufsion
Intravenous fluids
Email Cervical collar

| -

Which of the following characterizes a Level | trauma center.

Which of the following is the most worrying cause = On call neurosurgeon

of hypotension in a trauma patient: 24-hour trauma surgeon
Hemorrhage Nurse practitioner run emergency department
Blood loss
Exsanguination Additem ~

What are important questions to ask of a patient
involved in a motor vehicle crash?

l

Add a new field

Add this form to my post
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Tip 9: Design Classroom Activities

Begin the class by using a focusing activity. This tasks the learners with using the background materials. Some possible ideas:

@ Ranking

@® OQuestion and Answer time
@ Think-pair-share

@ Identify 1 confusing point
@® What if?

Then move on to the main classroom activity. These should explore Bloom'’s higher domains such as application, analysis, evaluation and creation,
and synthesis. The objectives should build upon the core knowledge learned from the home modules. Try to bring the lesson home and into the
clinical realm.

Here are some examples:
@ Application: table top case scenarios and simulation
@ Analysis: debate over controversies or journal articles, comparing diagnostic and treatment strategies, analyze the quality of a case
management (from M&M or even a television show)
@ Creation: have learners create and role play scenarios involving patients, family members, physicians and other health care team members
for difficult conversations

Allow the content to guide you. Support experimentation. For example, learning procedures should allow students to get out the simulators during
class time. Using common tools (e.g., slit lamp) will need additional resources. In general, discussion is a good place to start. The conversational
style is low risk and learners love the time to interact with each other and the teachers. Branch out from here. Common themes include
mind-mapping, content creation, projects, small group work, etc.

Instruction is shifted from instructor-focused to learner-centered. Let learners lead the discussion as much as possible, ask questions of one another
and teach one another. Teachers adopt a supportive, but far from passive role. The instructor’s job is to:

1. Design activities that promote discussion between members of the group

2. Help initiate discussion with probing, open-ended questions. Ask learners to:
a. Explain or elaborate their ideas,
b. Provide the rationale for their decisions,
c. Ask for alternative methods to approach the problem,
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d. Link these concepts to previous material by creating a concept map

e. Reflect on how well the group is completing the assignment predict outcomes, or
f. Generate hypotheses.

3. Provide feedback when learners are going off track or quiet
4. Continually observe and make adjustments as appropriate.

Will the learners really teach each other? If learners attained the foundational knowledge outside of class and the classroom activity is properly
created, there is usually spontaneously participation. When this happens, the instructor can simply step out of the way and observe. You become
“the guide on the side” instead of the traditional lecturer role of “sage on the stage” (King 1993). As Dr. Eric Mazur said in his “Confessions on a
Converted Lecturer” talk, our job should “shift [the] focus from teaching to helping learners learn.”

A few last pieces of advice:

@ Avoid the temptation to lecture in class, this work has already been done in your videos.
@ Resist the urge to complete the work for learners, let them struggle with the problems.

@ You don't need to cover everything, the activity of critical thinking is much more important.
@ Lead learners so that they can discover the answers themselves.

Workshop Activity

List some activities for students to practice the higher order objectives you listed in step 1:
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Tip 10: Feedback. Finish Strong!

Ask learners:
So what, now what?
What are you going to do with what you've learned?

Consider an exit survey
List 3 things learned
|dentify the most important points, and why
What is the clearest point? Muddiest point?

The second role of the instructor during class time is to provide feedback to learners. However, feedback can come from multiple sources, such as
the environment (e.g., a simulation mannequin provides feedback), other learners (e.g., from classroom discussion) and the learner themselves (e.g.,
self-reflection - one of the most powerful methods).

Instructors continually observe learners and assessing their work during the class activity. While learners are allowed to make and explore their
mistakes during discussion, the instructors are there to redirect learners if they deviate too far or become frustrated. Teachers can also identify
individual learners that may need extra attention and provide individualized, directed feedback in real time.

The takeaway knowledge, skills and attitudes with which learners should walk away come from your objectives. Both the instructor and learner
need to measure how well the learner achieved those objectives.

Learners use this feedback to adjust their performance on subsequent activities, whether that is in another classroom activity or in a real-world
application. Novice learners may need advice on how they can tweak their performance in order to achieve the objectives. Advanced learners, who
have easily attained the objectives, can benefit from advice on the subtleties to make their performance more efficient.

Instructors use this feedback to design future instruction. If a large proportion of the class has difficulty in one area, the teacher can alter the
pre-class modules or in-class activity to better emphasize those areas.
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Workshop Activity

How would you assess and create feedback sources for your learners:

From Self:

From the Environment:

From Peers:

From Instructors:
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